
Chapter 4

Working with Drawing Aids

After completing this chapter, you will be able to:
• Set up layers and assign colors and line types to them.
• Use the Properties toolbar to directly change the general object properties.
• Change the properties of objects using the PROPERTIES command.
• Determine current, and global line type scaling and LTSCALE factor for plotting.
• Set up Grid, Snap, and Ortho modes on the basis of the drawing requirements.
• Use Object Snaps and understand their applications.
• Combine Object Snap modes and set up running Object Snap modes.
• Use AutoTracking to locate keypoints in a drawing.

Learning Objectives
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Figure 4-1  Drawing lines and dimensions in different overlays

In this chapter, you will learn about the drawing setup and the factors that affect the quality and
accuracy of a drawing. This chapter contains a detailed description of how to set up layers. You
will also learn about some other drawing aids, such as Grid, Snap, and Ortho. These aids will
help you to create drawings accurately and quickly.

UNDERSTANDING THE CONCEPT AND USE OF LAYERS
The concept of layers can be best explained by using the concept of overlays in manual drafting.
In manual drafting, different details of the drawing can be drawn on different sheets of paper, or
overlays. Each overlay is perfectly aligned with the others. Once all of them are placed on top of
each other, you can reproduce the entire drawing. As shown in Figure 4-1, the object lines are
drawn in the first overlay and the dimensions in the second. You can place these overlays on top
of each other and get a combined look at the drawing.

Instead of using overlays in AutoCAD LT, you can use layers. Each layer is assigned a name. You
can also assign a color and line type to these layers. For example, in Figure 4-2 the object lines
are drawn in the OBJECT layer and the dimensions are drawn in the DIM layer. The object
lines will be red because red has been assigned to the OBJECT layer. Similarly, the dimension
lines will be green because the DIM layer has been assigned the green color. You can display the
layers together, individually, or in any combination.

Advantages of Layers
1. Each layer can be assigned a different color. Assigning a particular color to a group of

objects is very important for plotting. For example, if all object lines are red, at the time of
plotting you can assign the red color to a slot (pen) that has the desired tip width
(e.g., medium). Similarly, if the dimensions are green, you can assign the green color to
another slot (pen) that has a thin tip. By assigning different colors to different layers you
can control the width of the lines when the drawing is plotted. You can also make a layer
plottable or nonplottable.
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2. The layers are useful for some editing operations. For example, to erase all dimensions in a
drawing, you can freeze or lock all layers except the dimension layer and then erase all
dimensions by using the Crossing option to select objects.

3. You can turn a layer off or freeze a layer that you do not want to be displayed or plotted.
4. You can lock a layer, which will prevent the user from accidentally editing the objects in it.
5. The colors also help you distinguish different groups of objects. For example, in architectural

drafting, the plans for foundation, floors, plumbing, electrical, and heating systems may all
be made in different layers. In electronic drafting and in PCB (printed circuit board), the
design of each level of a multilevel circuit board can be drawn on a separate layer. Similarly,
in mechanical engineering, the main components of an assembly can be made in one layer,
other components such as nuts, bolts, keys, and washers can be made in another layer, and
the annotations such as datum symbols and identifiers, texture symbols, Balloons, and Bill
of Materials can be made in yet another layer.

WORKING WITH LAYERS

You can use the Layers toolbar (Figure 4-3) or the Format menu to invoke the Layer
Properties Manager dialog box. Using this dialog box, you can perform the functions
associated with layers. For example, you can create new layers, assign them colors and

linetypes, or perform any operation that is shown in the dialog box. You can also perform some
layer functions, such as freeze, thaw, lock, unlock, and so on, directly from the Layers toolbar.
When you invoke the Layer Properties Manager dialog box, a default layer with the name 0 is
displayed. It is the current layer and any object you draw is created in it. There are certain
features associated with each layer such as color, linetype, and lineweight. Layer 0 has a default
color white, linetype continuous, and lineweight default.

Figure 4-2  Drawing lines and dimensions in different layers

Toolbar: Layers > Layer Properties Manager
Menu: Format > Layer
Command: LAYER or LA
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Creating New Layers
To create new layers, choose the New Layer button in the Layer Properties Manager dialog
box. Alternatively, you can also press ALT+N to create a new layer. A new layer with the name
Layer1 and the properties of 0 layer is created and listed in the dialog box just below layer 0, see
Figure 4-4.

If you have more layers, in addition to layer 0, the new layer will have the properties of the layer
that is selected in the Layer Properties Manager dialog box. You can change or edit the name
by selecting it and then entering a new name. If more than one layer is selected, the new layer is
placed at the end of the layers list and has the properties of the layer selected last. Right-clicking
anywhere in the Layers list area of the Layer Properties Manager dialog box displays a shortcut
menu that also gives you an option to create a new layer. You can right-click on the layer whose
properties you want to use in the new layer and then select New Layer from the shortcut menu.

Layer names
1. A layer name can be up to 255 characters long, including letters (a-z), numbers (0-9), special

characters ($ _ -), and spaces. Any combination of lower and uppercase letters can be used
while naming a layer. However, characters such as <>;:,’?”=, and so on are not valid
characters while naming a layer.

2. The layers should be named to help the user identify the contents of the layer. For example,
if the layer name is HATCH, a user can easily recognize it and also its contents. On the
other hand, if the layer name is X261, it is hard to identify its contents.

3. Layer names should be short, but should also convey the meaning.

Figure 4-3  The Layers toolbar

Figure 4-4  The Layer Properties Manager dialog box with a new layer created
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Note
The length of the layer name is controlled by the EXTNAMES system variable that has a default
value 1. If you change it to 0, the layer name is allowed to be up to thirty-one characters long but
it cannot include special characters and spaces.

Tip
If you exchange drawings with or provide drawings to consultants or others, it is very important
that you standardize and coordinate layer names and other layer settings.

Making a Layer Current
To draw an object in a particular layer, you need to make it the current layer. Only one layer can
be made current, in which new objects will be drawn. To make a layer current, double-click on it
in the list box; the selected layer is made current. You can also select the name of the desired
layer and then choose the Set Current button in the dialog box. AutoCAD LT will display a
check mark in the Status column of that row in the Layer Properties Manager dialog box.
Also, the name of the current layer is displayed next to Set Current button above the list of
layers. Choose OK to exit the dialog box.

Right-clicking on a layer in the layer list box displays a shortcut menu that gives you an option
(Set current) to make the selected layer current, see Figure 4-5.

The name and properties of the current layer are displayed in the Layers toolbar. You can also
make a layer current by selecting it from the Layer Control drop-down list in the Layers
toolbar. You can use the CLAYER system variable to make the layer current from the Command
prompt. Choosing the Make Object’s Layer Current button from the Layers toolbar prompts

Figure 4-5  The Layer Properties Manager dialog box with the shortcut menu
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you to select the object whose layer you want to make current. After selecting an object, the layer
associated with that object will be made current.

Note
When you select more than one layer at a time using the SHIFT key, the Make Current option
is not displayed in the shortcut menu in the Layer Properties Manager dialog box. This is
because only one layer can be made current at a time.

Controlling the Display of Layers
You can control the display of the layers by selecting the Turn a layer On or Off, Freeze or thaw
in ALL viewports, and Lock or Unlock a layer toggle buttons in the list box of any particular
layer.

Turn a Layer On or Off
With the Turn a layer On or Off toggle icon (light bulb), you can turn the layers on or off. The
layers that are turned on are displayed and can be plotted while the layers that are turned off are
not displayed and cannot be plotted. You can perform all the operations such as drawing and
editing in the layer that has been turned off.
You can turn the current layer off, but
AutoCAD LT will display a warning box
informing you that the current drawing layer
has been turned off. You can also turn the layer
on or off by clicking on the On/Off toggle
icon from the Layer drop-down list in the
Layers toolbar, see Figure 4-6.

Freeze or Thaw in ALL Viewports
While working on a drawing, if you do not want to see certain layers, you can also use the Freeze
or thaw in ALL viewports toggle icon (sun/snowflakes) to freeze them. You can use the Layers
toolbar or the Layer Properties Manager dialog box to freeze or thaw a layer. No modifications
can be done in the frozen layer. For example, while editing a drawing, you may not want the
dimensions to be changed and displayed on the screen. To avoid this, you can freeze the Dim
layer, in which you are dimensioning the objects. The frozen layers are invisible and cannot be
plotted. The Thaw option negates the effect of the Freeze option, and the frozen layers are
restored to normal. The difference between the Off option and the Freeze option is that the
frozen layers are not calculated by the computer while regenerating the drawing, and this saves
time. The current layer cannot be frozen.

Current or New VP Freeze
When you select a layout in the Model/Layout tab (by clicking on Layout1), or you set the
TILEMODE variable to 0 (see Chapter 11, Model Space Viewports, Paper Space Viewports and
Layouts), you can freeze or thaw the selected layers in the active floating viewport by selecting the
Freeze or thaw in current viewport icon for the selected layers. Once you are in a floating
viewport, the Current VP Freeze and New VP Freeze icons are added in the Layer Properties
Manager dialog box toward the right side, see Figure 4-7.

Figure 4-6  Turning layer Dim off from the
Layers toolbar



Working with Drawing Aids                                                                                           4-7

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. F
or

 e
ng

in
ee

ri
ng

 s
er

vi
ce

s,
 c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

If the icon is not visible, you can move the scroll bar at the bottom of the layer list box to display
it. Also, the Freeze or thaw in current viewport icon in the Layers toolbar becomes available
once you have viewports. Selecting this icon makes the selected layers invisible in the active
floating viewport only. The frozen layers will still be visible in other viewports. If you want to
freeze some layers in the new floating viewports, then select the New VP Freeze toggle icon for
the selected layers. AutoCAD LT will freeze the layers in subsequently created new viewports
without affecting the viewports that already exist. (Paper space is discussed in Chapter 11.) Also,
check the VPLAYER command for selectively freezing layers in viewports.

Tip
The widths of the column headings in the Layer Properties Manager dialog box can be
decreased or increased by positioning the cursor between the column headings  on the separator
(the cursor turns into a two-sided arrow). Now, hold down the pick button of your pointing
device and drag the cursor to the right or left. This way you can vary the widths of the column
headings.

Lock or Unlock a Layer
While working on a drawing, if you do not want to accidentally edit some objects on a particular
layer but still need to have them visible, you can use the Lock/Unlock toggle icon to lock the
layers. When a layer is locked, you can still use the objects in the locked layer for Object Snaps
and inquiry commands such as LIST. You can also make the locked layer the current layer and
draw objects on it. Note that you can also plot the locked layer. The Unlock option negates the
Lock option and allows you to edit objects on the layers previously locked.

Make a Layer Plottable or Nonplottable
If you do not want to plot a particular layer, for example, construction lines, you can use the Plot
toggle icon (printer) to make the layer plottable or nonplottable. This icon is available in the
Layer Properties Manager dialog box. The construction lines will not be plotted if its layer is
made nonplottable.

Tip
It is faster and convenient to use the Layer drop-down list in the Layers toolbar to make a
layer current and control the display features of the layer (On/Off, Freeze/Thaw, Lock/Unlock).

Assigning Linetype to Layer
By default, layers are assigned continuous linetypes and white color, if no layer is selected at the
time of creating a new layer. Otherwise, the new layer takes the properties of the selected layer. To

Figure 4-7  The Layer Properties Manager dialog box with the Current and New VP Freeze icons



4-8                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

assign a new linetype to a layer, click on the field under the Linetype column of that layer in the
Layer Properties Manager dialog box. AutoCAD LT will display the Select Linetype dialog
box. This dialog box displays the linetypes that are defined and loaded on your computer.
Select the new linetype and then choose the OK button. The linetype that you select is assigned
to the layer you selected initially.

If you have not loaded the linetypes and are opening the Select Linetype dialog box for the first
time, only the Continuous linetype is displayed, as shown in Figure 4-8.

You need to load the linetypes you want and then assign them to the layers. To load the line-
types, choose the Load button in the Select Linetype dialog box. This displays the Load or
Reload Linetypes dialog box, see Figure 4-9. This dialog box displays all linetypes in the
acad.lin file. In this dialog box, you can select a single linetype or a number of linetypes by
pressing and holding the SHIFT or CTRL key and then selecting the linetypes. If you right-click,
AutoCAD LT displays the shortcut menu, which you can use to select all linetypes. Then by
choosing the OK button, the selected linetypes are loaded and therefore displayed in the Select
Linetype dialog box. Now, select the desired linetype and choose OK. The selected linetype is
assigned to the selected layer.

Note
By default, the linetypes in the acad.lin file are displayed in the Load or Reload Linetypes
dialog box. You can select the linetypes in the acadiso.lin file by choosing the File button in the
dialog box and then opening the acadiso.lin file from the Select Linetype Files dialog box.

Tip
You can also create your own linetypes. This is discussed in detail in Chapter 31, Creating
Linetypes and Hatch Patterns.

Figure 4-8  The Select Linetype dialog box
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Assigning Color to Layer
To assign a color, select the color swatch in a particular layer in the Layer Properties Manager
dialog box; AutoCAD LT will display the Select Color dialog box. Select the desired color and
then choose the OK button. The color you selected will be assigned to the selected layer. The
number of colors is determined by your graphics card and monitor. Most color systems support
eight or more colors. If your computer allows it, you may choose a color number between 0 and
255 (256 colors). The following are the first seven standard colors:

    Color             Color Color  Color
   number             name number name
———————————— ———————————

1            Red     5   Blue
2            Yellow     6   Magenta
3            Green     7   White
4            Cyan

Note
The use of nonstandard colors may cause compatibility problems if the drawings are used on other
systems with different colors. On a light background, white color appears black. Certain colors
are hard to see on light backgrounds and others are hard to see on dark backgrounds, and so you
may have to use different colors than those specified in some examples and exercises.

Assigning Lineweight to Layer
Lineweight is used to give thickness to the objects in a layer. This thickness is displayed on the
screen if the display of the lineweight is on. The lineweight assigned to the objects can also be
plotted. If you make a sectional plan at a certain height, you can assign a layer with a larger value of

Figure 4-9  The Load or Reload Linetypes dialog box
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Figure 4-10  The Lineweight dialog box

lineweight to create the objects through which the section is made. Another layer with a lesser
lineweight can be used to show the objects through which the section does not pass. To assign a
lineweight to a layer, select the layer and then click on the lineweight associated with it; the Lineweight
dialog box is displayed, see Figure 4-10. Select a lineweight from the Lineweights list. Choose OK
to return to the Layer Properties Manager dialog box.

Note
The LWEIGHT command for editing and displaying the lineweight is discussed in detail later in
this chapter.

Assigning Plot Style to Layer
Plot style is a group of property settings such as color, linetype, and lineweight that can be
assigned to a layer. The applied plot style affects the drawings while plotting only. The drawing,
in which you are working, should be in a named plot style mode (.stb) to make the plot style
available in the Layer Properties Manager dialog box. If the Plot Style icon in the dialog box
is not available, then you are in a color-dependent mode (.ctb). To make it available, open the
Options dialog box from the Tools menu and choose the Plot and Publish tab. In this tab,
choose the Plot Style Table Settings button to invoke the Plot Style Table Settings dialog box.
In this dialog box, select the Use named plot style radio button from the Default plot style
behavior for new drawings area and then exit both the dialog boxes. After changing the plot
style to named plot style dependent, you have to open a new AutoCAD LT session to apply this
setting. The default plot style is Normal, in which the color, linetype, and lineweight are BYLAYER.
To assign the plot style to a layer, select the layer and then click on its plot style; the Select Plot
Style dialog box is displayed, as shown in Figure 4-11, where you can select a specific plot style
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from the Plot styles list of available plot styles.
Plot styles have to be created before you can use
them (see Chapter 12, Plotting Drawings). Choose
OK to return to the Layer Properties Manager
dialog box.

Tip
You can also change the plot style mode from
the command line by using the
PSTYLEPOLICY system variable. A value
of 0 sets it to the color-dependent mode and
a value of 1 sets it to the named mode.

Deleting Layers
You can delete a layer by selecting and then
choosing the Delete Layer button in the Layer
Properties Manager dialog box. The layer that
you delete will have a cross in the Status column.
Choose the Apply button to confirm the deletion.
Remember that to delete a layer, it is necessary that
it should not contain any objects. You cannot
delete layers 0, Defpoints (created while
dimensioning), and Ashade (created while
rendering),  current layer, and an Xref-dependent
layer.

Selective Display of Layers
If the drawing has a limited number of layers it is easy to scan through them. However, if the
drawing has a large number of layers, it is sometimes difficult to search through the layers. To
solve this problem, you can use layer filters. By defining filters, you can specify the properties
and only the layers that match those properties will be displayed in the Layer Properties
Manager dialog box. By default, All and All Used Layers filters are created. The All filter is
selected by default, which ensures that all the layers are displayed. If you select the All Used
Layers filter, only those layers will be displayed that are used in the drawing. Rest of the layers
are not displayed.

AutoCAD LT allows you to create a layer property filter or a layer group filter. A layer group filter
can have additional layer property filters. To create a filter, choose the New Property Filter
button, which is the first button on the top left corner of the dialog box. When you choose this
button, a new property filter is added to the list and the Layer Filter Properties dialog box is
displayed, as shown in Figure 4-12.

The current name of the filter is displayed in the Filter name edit box. You can enter any name
for the filter in this edit box. Using this dialog box, you can create filters based on any property
column in the Filter definition area. The layers that will be actually displayed in the Layer

Figure 4-11  The Select Plot Style dialog box
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Properties Manager dialog box, based on the filter that you create, are shown in the Filter
preview area. For example, to list only those layers that are red in color,  click on the field under
the Color column. A swatch [...] button is displayed in this field. Choose this button to display
the Select Color dialog box. Select red from this dialog box and then exit it. You will notice that
the filter row color is changed to red and the display of layers in the Filter preview is modified
such that only the red layers are displayed.

After creating the filter, exit the Layer Filter Properties dialog box. The layer filter is selected
automatically in the Layer Properties Manager dialog box and only the layers that satisfy the
filter properties are displayed. You can restore the display of all the layers again by clicking on
the All filter.

Note
To modify a layer filter, double-click on it; the Layer Filter Properties dialog box is displayed.
Modify the filter and then exit the dialog box.

In the Layer Properties Manager dialog box, when you select the Invert filter check box, you
invert the filter that you have selected. For example, if you have selected the filter to show all the
layers, none of the layers will be displayed. You can also apply the current layer filter to the
Layer Control list in the Layers toolbar by selecting the Apply to layers toolbar check box.
Choose OK in the dialog box. You will notice that only the filtered layers are displayed in the
Layer Control drop-down list of the Layers toolbar. Note that in the Layer Properties Manager
dialog box, the current layer is not displayed in the list box if it is not among the filtered layers.

Figure 4-12  The Layer Filters Properties dialog box
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Layer States
You can save and then restore the properties of all the layers in a drawing using the Layer States
Manager dialog box, which is invoked using the Layer States Manager button. While working
on a drawing at any point in time, you can save all the layers with their present properties
settings under one name and then restore it anytime later. Invoke the Layer States Manager
dialog box and specify the name for saving the layers. You can specify the different states and
properties of the layers that you want to save. Choosing the OK button saves the checked states
and properties of the layers. However, this state is saved only for the current file. If you want to
use the current layer state in other files also, choose the Export button to invoke the Export
layer state dialog box. Enter the name for the layer state. The layer state is exported with the .las
extension.

You can import the layer state later in any other file using the Layer States Manager dialog box.
In this dialog box, you are allowed to edit the states and properties of the saved state. You can
rename and delete a state.

Tip
The linetypes will be restored with the layer state in a new drawing file only if those linetypes
are already loaded using the Select Linetype dialog box.

Set up four layers with the following linetypes and colors. Then create the drawing shown in
Figure 4-13 (without dimensions).

Layer name Color   Linetype      Lineweight
     Obj Red Continuous         0.012"
     Hid Yellow Hidden         0.008"
     Cen Green Center         0.006"

Example 1 Mechanical

Figure 4-13  Drawing for Example 1
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In this example, assume that the limits and units are already set. Before drawing the lines, you
need to create layers and assign colors, linetypes, and lineweights to them. Also, depending on
the objects that you want to draw, you need to set that layer as current. In this example, you will
create the layers using the Layer Properties Manager dialog box. You will use the Layers
toolbar to set the layers current and then draw the figure.

1. As the lineweights specified are in inches, first change the units for the lineweight, if they
are in millimeters. Choose Format > Lineweight from the menu bar to display the Lineweight
Settings dialog box. Select the Inches [in] radio button in the Units for Listing area of the
dialog box and then choose the OK button.

2. Choose the Layer Properties Manager button in the Layers toolbar, or choose Layer in
the Format menu, or enter LAYER at the Command prompt to display the Layer
Properties Manager dialog box. The layer 0 with default properties is displayed in the list
box.

3. Choose the New Layer button; AutoCAD LT automatically creates a new layer (Layer1)
having the default properties and displays it in the list box. Change its name by entering
Obj in place of Layer1.

4. Now choose the color swatch of this layer to display the Select Color dialog box. Select the
Red color and then choose OK. Red color is assigned to the Obj layer.

5. Choose the lineweight of the layer to display the Lineweight dialog box. Select 0.012" and
then choose OK. A lineweight of 0.012" is assigned to the Obj layer.

6. Again, choose the New Layer button; a new layer (Layer1) having the properties of layer
Obj is created. Change its name by entering Hid in place of Layer1.

7. Choose the color swatch to display the Select Color dialog box. Select the Yellow color and
then choose OK.

8. Choose the linetype of the layer to display the Select Linetype dialog box. If the linetype
HIDDEN is not displayed in the dialog box, choose the Load button to display the Load
and Reload Linetypes dialog box. Select HIDDEN from the list and choose the OK button.
Select HIDDEN in the Select Linetype dialog box and then choose OK.

9. Choose the lineweight of the layer to display the Lineweight dialog box. Select 0.008" and
then choose OK. A lineweight of 0.008" is assigned to the Hid layer.

10. Similarly create the new layer Cen and assign color Green, linetype CENTER, and lineweight
0.006" to it.

11. Select the Obj layer and then choose the Set Current button to make the Obj layer current,
see Figure 4-14. Choose the OK button to exit the dialog box.
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12. Choose the LWT button from the status bar to turn on the displayed of the lineweight.
Using the LINE command, draw the object lines in the Obj layer.

Command: LINE �
Specify first point: 9,1 �
Specify next point or [Undo]: 9,9 �
Specify next point or [Undo]: 11,9 �
Specify next point or [Close/Undo]: 11,1 �
Specify next point or [Close/Undo]: 9,1 �
Specify next point or [Close/Undo]: 1,3 �
Specify next point or [Close/Undo]: 1,7 �
Specify next point or [Close/Undo]: 9,9 �
Specify next point or [Close/Undo]: �

Command: �  (Invokes the LINE command.)
Specify first point: 1,3 �
Specify next point or [Undo]: 9,3 �
Specify next point or [Undo]: �

Command: �  (Invokes the LINE command.)
Specify first point: 1,7 �
Specify next point or [Undo]: 9,7 �
Specify next point or [Undo]: �

13. Make the Hid layer current from the Layers toolbar. Select the down arrow in the Layer
Control list box to display the drop-down list, as shown in Figure 4-15. Select the Hid layer
from the list to make it current.

14. Now draw the following lines, using the LINE command.

Command: LINE �
Specify first point: 1,4 �
Specify next point or [Undo]: 11,4 �
Specify next point or [Undo]:��

Figure 4-14  Layers created for Example 1
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Exercise 1 Mechanical

Command: � (Invokes the LINE command.)
Specify first point: 1,6������
Specify next point or [Undo]: 11,6 �
Specify next point or [Undo]:��

15. Again, choose the down arrow in the Layer Control list box to display the drop-down list.
Select the Cen layer from the list to make it current.

16. Now draw the following lines using the LINE command.

Command: LINE��
Specify first point: 0,5 �
Specify next point or [Undo]: 12,5 �
Specify next point or [Undo]: �

Set up layers with the following linetypes and colors. Then make the drawing (without dimensions)
as shown in Figure 4-16. The distance between the dotted lines is 1 unit.

Layer name Color Linetype
Object Red Continuous
Hidden Yellow Hidden
Center Green Center
Dimension Blue Continuous

Tip
Remember that the Linetype Control, Lineweight Control, Color Control, and the Plot
Style Control list boxes in the Properties toolbar should display ByLayer as the current
properties of the objects. This is to ensure that when you draw an object, it takes the properties
assigned to the layer, in which the object is drawn.

Figure 4-15  Making the Hid layer current from the Layers toolbar
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LINETYPE COMMAND
The LINETYPE command can be used to load, delete, and make current the linetype which
can be used to draw an object. You can invoke this command from the Format menu or by
entering LINETYPE at the Command prompt, the Linetype Manager dialog box is displayed,
as shown in Figure 4-17. By default, the linetypes displayed are ByLayer, ByBlock, and
Continuous. Choosing the Load button displays the Load or Reload Linetypes dialog box,
which is also displayed from the Layer Properties Manager dialog box. The linetypes that you
load here will be displayed in the Select Linetypes dialog box also. Similarly, if you have
loaded some linetypes using the Layer Properties Manager dialog box, they will be displayed
in the Linetype Manager dialog box. You can make a linetype current by using the Current
button. All the new objects will be drawn with the current linetype. If you have chosen the
current linetype as ByLayer, then the object will be drawn with the linetype of the layer. You can
also make any linetype current other than ByLayer, and the object will be drawn with the
particular linetype. The current linetype is also displayed in the Linetype Control drop-down
list of the Properties toolbar.

LWEIGHT COMMAND
The LWEIGHT command can be used to assign a lineweight to an object. You can invoke this
command by selecting Lineweight from the Format menu or by entering LWEIGHT at the
Command prompt to display the Lineweight Settings dialog box, see Figure 4-18. You can also
use the Settings option in the shortcut menu, displayed on right-clicking on the LWT button
on the status bar, to invoke this dialog box. In this dialog box, you can choose the current
lineweight for the objects. You can change the units for the lineweight and also the display of
lineweights for the current drawing. The lineweights are displayed in pixel widths and depending
on the lineweight value chosen, the lineweights are displayed if the Display Lineweight check
box is selected. For a large drawing, this increases the regeneration time and should be cleared.

Figure 4-16  Drawing for Exercise 1
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As mentioned earlier, you can also turn the display of lineweights to on or off directly from the
status bar by choosing the LWT button. The slider bar for Adjust Display Scale affects the
regeneration time as well. You can keep the slider bar at Max for getting a good display of
different lineweights on the screen in the Model space; otherwise, keep it at Min for a faster
regeneration.

Figure 4-18  The Lineweight Settings dialog box

Figure 4-17  The Linetype Manager dialog box
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Tip
For the drawings that have a large number of entities, you should keep the display scale at the
minimum value for increasing the performance of AutoCAD LT. It is also recommended that
you turn off the display of the lineweight from the status bar to reduce the regeneration time.

OBJECT PROPERTIES
An object, when created, has certain properties such as color, linetype, lineweight, plot style,
and layer associated with it. These properties of an object can be changed and made current
using the Properties toolbar or the Properties palette.

Properties Toolbar
You can use the Properties toolbar to directly change the general properties of the selected
objects and also set those properties current.

Color
Select the object whose color you want to change. The current color of the object is displayed in
the Color Control list box. Display the list of colors by selecting the drop-down arrow, shown in
Figure 4-19, and select a new color. The color of the selected object is changed to the new color.
If you want to set a different color current, choose a color from the drop-down list without
selecting any object. By default, the color of an object is ByLayer and hence it takes the color
assigned to the layer, in which it is created. From the Color drop-down list, you can select any
other color to assign the color explicitly to the objects drawn. This color is set as current and all
the new objects will be drawn in this color. If you want to assign a color that is not displayed in
the list, choose the Other option to display the Select Color dialog box. You can select the
desired color in this dialog box, and then choose the OK button.

Linetype
From the Linetype Control drop-down list shown in Figure 4-20, you can select the new linetype
and assign it to the selected object. You can also make a linetype current by selecting it from the
list. By default, the linetype of an object is ByLayer. The linetypes that are loaded from the

Figure 4-19  Setting object color from
the Properties toolbar
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LAYER or the LINETYPE command will be listed. To assign a
linetype that is not displayed in the list, choose the Other option
to display the Linetype Manager dialog box. You can use the
Load button to load other linetypes.

Lineweight
Similarly, you can select a different lineweight value from the
Lineweight Control drop-down list in the Properties toolbar to
assign to the selected object. Also, you can set a new lineweight
current by selecting it from the list.

Plot Style
You can select a different plot style for the selected object from the Plot Style Control drop-down
list. Also, you can set a new plot style current by selecting it from the list.

Note
When you set a linetype, lineweight, or color current, all the objects drawn thereafter will have
the current linetype, lineweight, and color. The properties of the current layer are not considered.
You need to set current those properties to ByLayer again such that the objects assume the
linetype, lineweight, color, or plot style of the layer, in which they are created.

PROPERTIES Palette

You can also use the PROPERTIES palette to change the general properties of the
selected objects and also set those properties current. The PROPERTIES palette is
displayed by invoking the PROPERTIES command. It can also be invoked by selecting

an object and then right-clicking to display a shortcut menu. From the shortcut menu, choose
Properties. The PROPERTIES palette is displayed, as shown in Figure 4-21, from where you
can change the different properties of the selected object. When you select the objects whose
properties you want to change, the PROPERTIES palette displays the properties of the selected
object. Depending on the object selected, the properties differ. You can also make the different
properties current by selecting no object and then selecting the particular properties in the
window. Right-clicking in the PROPERTIES palette displays a shortcut menu from where you
can choose to Allow Docking or Hide the palette.

When you select Color from the General list, the color of the selected object is displayed, along
with a drop-down arrow. From this list, you can select any color to assign to the selected object.
If you want to assign a color that is not displayed in the list, choose the Select Color option to
display the Select Color dialog box. You can select the desired color in this dialog box, and
then choose the OK button.

Toolbar: Standard > Properties
Menu: Tools > Properties
Command: PROPERTIES, CH, MO

Figure 4-20  The Linetype
Control list box
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Similarly, you can set current the linetype, lineweight,
linetype scale, and other properties for the other objects
individually. You can also assign a hyperlink to an object.
The Hyperlink field in this window displays the name
and description of the hyperlink, if any, assigned to the
object. If there is no hyperlink attached to the object,
this field is blank. To add a hyperlink to the selected
object, click on this field; the  [...] button is displayed in
this field. Choose the [...] button; the Insert Hyperlink
dialog box is displayed where you can enter the path of
the URL or file you want to link to the selected object.

Tip
You can keep the PROPERTIES palette open while
working in a drawing. When no object is selected,
the current settings of the drawing are listed.
Whenever you need to change a certain property of
an object, select the object so that its properties are
listed in the PROPERTIES palette and make the
required changes.

Note
You can use the CHPROP command to change the
properties of an object from the command line. You
can also change the general properties of an object by
using the Properties option of the CHANGE
command. Both these commands, along with the
Geometry portion of the PROPERTIES palette to
edit the objects, have been discussed in Chapter 18.

The system variables CECOLOR, CELTYPE, CELWEIGHT control the current color, linetype,
and lineweight of the object. You can set the properties of the objects current using these variables
from the command line.

When you set the property of the object current, it does not consider the property of the layer, in
which the object will be drawn.

Tip
It is easier and faster to set the properties of the object current from the Properties toolbar.
It is better to leave the different properties of objects at ByLayer to avoid confusion.

Draw a hexagon on the Obj layer in red. Let the linetype be hidden. Now, use the PROPERTIES
palette to change the layer to some other existing layer, the color to yellow, and the linetype to
continuous.

Figure 4-21 The  PROPERTIES palette

Exercise 2 General
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GLOBAL AND CURRENT LINETYPE SCALING
The LTSCALE system variable controls the global scale factor of the lines in a drawing. For
example, if LTSCALE is set to 2, all lines in the drawing will be affected by a factor of 2. Like
LTSCALE, the CELTSCALE system variable controls the linetype scaling. The difference is
that CELTSCALE determines the current linetype scaling. For example, if you set CELTSCALE
to 0.5, all lines drawn after setting the new value for CELTSCALE will have the linetype scaling
factor of 0.5. The value is retained in the CELTSCALE system variable. Line (a) in Figure 4-22
is drawn with a CELTSCALE factor of 1; line (b) is drawn with a CELTSCALE factor of 0.5. The
length of the dash is reduced by a factor of
0.5 when CELTSCALE is 0.5. The net scale
factor is equal to the product of CELTSCALE
and LTSCALE. Figure 4-22(c) shows a line
that is drawn with LTSCALE of 2 and
CELTSCALE of 0.25. The net scale factor =
LTSCALE X CELTSCALE = 2 X 0.25 = 0.5.
You can also change the global and current
scale factors by entering a desired value in the
Linetype Manager dialog box. If you choose
the Show details button, the properties
associated with the selected linetype are
displayed, as shown in Figure 4-23. You can
change the values according to your drawing
requirements.

LTSCALE FACTOR FOR PLOTTING
The LTSCALE factor for plotting depends on the size of the sheet you use to plot the drawing.
For example, if the limits are 48 by 36, the drawing scale is 1:1, and to plot the drawing on a 48"
by 36" size sheet, then the LTSCALE factor is 1. If you check the specification of the Hidden
linetype in the acad.lin file, the length of each dash is 0.25. Hence, when you plot a drawing
with 1:1 scale, the length of each dash in a hidden line is 0.25.

However, if the drawing scale is 1/8" = 1' and you want to plot the drawing on 48" by 36" paper,
the LTSCALE factor must 8 X 12 = 96. The length of each dash in the hidden line will increase
by a factor of 96, because the LTSCALE factor is 96. Therefore, the length of each dash will be
(0.25 X 96 = 24) units. At the time of plotting, the scale factor must be 1:96 to plot the 384' by
288' drawing on 48" by 36" paper. Each dash of the hidden line that was 24" long on the drawing

Figure 4-22  Using CELTSCALE to control
current linetype scaling

Figure 4-23  The Details area of the Linetype Manager dialog box
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will be 24/96 = 0.25" long when plotted. Similarly, if the desired text size on the paper is 1/8",
the text height in the drawing must be 1/8 X 96 = 12".

     LTSCALE factor for PLOTTING = Drawing Scale

Sometimes your plotter may not be able to plot a 48" by 36" drawing, or you might like to
decrease the size of the plot so that the drawing fits within a specified area. To get the correct
dash lengths for hidden, center, or other lines, you must adjust the LTSCALE factor. For example,
if you want to plot the previously mentioned drawing in a 45" by 34" area, the correction factor
is:

Correction factor = 48/45
= 1.0666

New LTSCALE factor = LTSCALE factor x Correction factor
= 96 x 1.0666
= 102.4

   New LTSCALE factor for PLOTTING = Drawing Scale x Correction Factor

Note
If you change the LTSCALE factor, all lines in the drawing are affected by the new ratio.

Changing Linetype Scale Using the PROPERTIES Command
You can also change the linetype scale of an object by using
the PROPERTIES command. When you invoke this
command, AutoCAD LT will display the
PROPERTIES palette. All the properties of the selected
objects are displayed in the PROPERTIES palette. To change
the current linetype scale, select the objects and then invoke
the PROPERTIES command to display the PROPERTIES
palette, see Figure 4-24. In this window, locate the Linetype
scale edit box in the General list and enter the new linetype
scale in the edit box. The linetype scale of the selected objects
is changed to the new value you entered.

Figure 4-24  The PROPERTIES
palette
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Figure 4-25  The DESIGNCENTER with the shortcut menu

WORKING WITH THE DESIGNCENTER

The DESIGNCENTER allows you to reuse and share contents in different drawings.
You can use this window to locate the drawing data with the help of search tools and
then use it in your drawing. You can insert layers, linetypes, blocks, layouts, external

references, and other drawing content in any number of drawings. Hence, if a layer is created
once it can be repeatedly used any number of times.

Open the DESIGNCENTER window and choose the Tree View Toggle button to display the
Tree pane and the Palette side by side (if they are not already displayed). Open the folder, in
which the drawing is saved containing the layers and linetypes you want to insert. You can use
the Load and the Up buttons to open the folder you want. For example, you want to insert some
layers and linetypes from the drawing c4d1 stored in the C:\AutoCAD 2006\c04-acad-2006 folder.
Browse to the folder and open c4d1 to display its contents. Select Layers and all the layers
created in c4d1 are displayed in the Palette. Press and hold the CTRL key down and select the
Border and CEN layers. Right-click to display the shortcut menu and choose Add Layer[s], as
shown in Figure 4-25. The two layers are added to the current drawing. You can also drag and
drop the desired layers into the current drawing. If you open the drop-down list in the Layers
toolbar, you will notice that the two layers are listed there. Similarly, you can insert the other
elements such as linetypes, blocks, dimension styles, and so on. You will learn more about
DESIGNCENTER in Chapter 6.

Toolbar: Standard > DesignCenter
Menu: Tools > DesignCenter
Command: ADCENTER
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DRAFTING SETTINGS DIALOG BOX

You can use the Drafting Settings dialog box to set drawing modes such
as Grid, Snap, Object Snap, Polar, Object Snap tracking, and Dynamic
Input. All these aids help you to draw accurately and also increase the
drawing speed. You can right-click on the SNAP, GRID, POLAR,
OSNAP, or DYN buttons on the status bar to display a shortcut menu, as
shown in Figure 4-26. From this shortcut menu, choose Settings to display
the Drafting Settings dialog box. This dialog box operates under four main tabs: Snap and
Grid, shown in Figure 4-27, Object Snap, Polar Tracking, and Dynamic Input. On starting
AutoCAD LT, you are provided with the default settings of these aids. You can change them
according to your requirements by using the Drafting Settings dialog box.

Setting Grid
The grid lines are lines of dots on the screen at predefined spacing, see Figure 4-28. These
dotted lines act as a graph that can be used as reference lines in a drawing. You can change the
distance between the grid dots as per your requirement. The grid pattern appears within the

Menu: Tools > Drafting Settings
Command: DSETTINGS

Figure 4-26  Settings
in the shortcut menu

Figure 4-27  The Snap and Grid tab of the Drafting Settings dialog box
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Figure 4-28  Grid lines

drawing limits, which helps to define the
working area. The grid also gives you a sense
of the size of the drawing objects.

Grid On (F7): Turning the Grid On
or Off
You can turn the grid on/off by using the Grid
On check box in the Drafting Settings dialog
box. You can also turn the grid on or off by
choosing the GRID button in the status bar,
or using the On or Off option in the shortcut
menu, when you right-click on the GRID
button in the status bar, or using the GRID
command. The function key F7 acts as a toggle key for turning the grid on or off. When the grid
is turned on after it has been off, the grid is set to the previous grid spacing.

Grid X Spacing and Grid Y Spacing
The Grid X spacing and Grid Y spacing edit boxes in the Drafting Settings dialog box are
used to define a desired grid spacing along the X and Y axes. For example, to set the grid
spacing to 0.5 units, enter 0.5 in the Grid X spacing and Grid Y spacing edit boxes, see
Figure 4-29. You can also enter different values for horizontal and vertical grid spacing, see
Figure 4-30. If you enter only the grid X spacing and then choose the OK button in the dialog
box, the corresponding Y spacing value is automatically set to match the X spacing value.
Therefore, if you want different X and Y spacing values, you need to set the X spacing first, and
then the Y spacing.

Note
Grids are specially effective in drawing when the objects in the drawing are placed at regular
intervals.

You can also use the GRID command to set the grid from the command line. At the prompt
sequence for the GRID command, you can use the Aspect option to assign a different value to the
horizontal and vertical grid spacings.

Figure 4-29  Controlling grid spacing Figure 4-30  Creating unequal grid spacing
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Tip
The grid and the snap grid (discussed in the next section) are independent of each other.
However, you can automatically display the grid lines at the same resolution as that of the snap
grid by using the Snap option of the GRID command. When you use this option, AutoCAD LT
will automatically change the grid spacing to zero and display the grid lines at the same
resolution as set for Snap. Therefore, in the Drafting Settings dialog box if the grid spacing
is specified as zero, it automatically adjusts to equal the Snap resolution.

In the GRID command, to specify the grid spacing as a multiple of the Snap spacing, enter X
after the value (2X).

Setting Snap
The snap is used to set increments for the cursor
movement. While moving the cursor, it is
sometimes difficult to position a point
accurately. The SNAP command allows you to
set up an invisible grid, see Figure 4-31 that
allows the cursor to move in fixed increments
from one snap point to another. The snap
points are the points where the invisible snap
lines intersect. The snap spacing is
independent of the grid spacing, and so the
two can have equal or different values. You
generally set snap to an increment of the grid
setting, for example, Snap=2 and Grid=10.

Snap On
You can turn the snap on/off and set the snap spacing from the Drafting Settings dialog box. As
in the case of GRID, the Snap On/Off selection turns the invisible snap grid on or off and moves
the cursor by increments. If the SNAP is off, the cursor will not move by increments. It will move
freely as you move the pointing device. When you turn the snap off, AutoCAD LT remembers
the value of the snap, and this value is restored when you turn the snap back on. You can also
turn the snap on or off by choosing the Snap
button in the status bar, or from the shortcut
menu displayed by right-clicking on the Snap
button in the status bar, or by using the function
key F9 as a toggle key for turning the snap on
or off.

Snap Angle
The Angle edit box in the Drafting Settings
dialog box is used to rotate the snap grid
through an angle, see Figure 4-32. Normally,
the snap grid has horizontal and vertical lines,
but sometimes you need the snap grid at an

Figure 4-31  Invisible Snap grid

Figure 4-32  Snap grid rotated 30-degree
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angle. For example, when you draw an auxiliary view (a drawing view that is at an angle to other
views of the drawing), it is more useful to have the snap grid at an angle. If the rotation angle is
positive, the grid rotates in a counterclockwise direction; if the rotation angle is negative, it
rotates in a clockwise direction.

X Base and Y Base
The X base and Y base edit boxes can be used to define the snap and grid origin point in the
current viewport relative to current UCS. When you specify the snap angle, the grid is rotated
around the base point whose coordinates are specified as the X base and Y base. Hence, you will
always have a grid point at this base point. The value is stored in the SNAPBASE system
variable.

Tip
It is generally preferable to rotate the UCS rather than rotate the snap grid. See Chapter 20 for
UCS.

Draw the auxiliary view of the object whose front view is shown in Figure 4-33. The auxiliary view
is shown in Figure 4-34.  The upper edge of the object is 2.5 units. The X and Y spacing of the
grid is 0.5 units. The thickness of the plate is 2 units; the length of the inclined face is 5 units.

Rotating the Snap Grid
It is assumed that the front view of the plate is already drawn with the coordinates of its starting
point as 1,1. Invoke the Drafting Settings dialog box and open the Snap and Grid tab. In the
Angle edit box, enter 30 and in the X base and Y base edit boxes enter 6 and 2, respectively, as
the coordinates of the point P0. This will rotate the snap grid at an angle of 30-degree through
point P0. Now you can draw the auxiliary view easily.

Command: LINE �
Specify first point: Select point (P1).

Figure 4-33  Front view of the plate for Example 2 Figure 4-34  Auxiliary view using rotated
snap grid

Example 2 Mechanical
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Specify next point or [Undo]: Move the cursor 2 units (4 grid points) right and select point (P2).
Specify next point or [Undo]: Move the cursor 5 units up and select point (P3).
Specify next point or [Close/Undo]: Move the cursor 2 units left and select point (P4).
Specify next point or [Close/Undo]: C �

Snap Type and Style
There are two Snap types, Polar snap and Grid snap. Grid snap snaps along the grid and is
either of Rectangular style or Isometric style. Rectangular is the default standard style.

Isometric Snap/Grid
You can select the Isometric snap radio button in the Snap type & style area, shown in Figure 4-35,
of the Drafting Settings dialog box to set the snap grid to isometric mode. The default is off
(standard). The isometric mode is used to make isometric drawings. In isometric drawings,
the isometric axes are at angles of 30, 90, and 150-degree. The Isometric snap/grid enables you
to display the grid lines along these axes, see Figure 4-36. Once you select the Isometric snap radio
button and choose OK in the dialog box, AutoCAD LT automatically changes the cursor to align
with the isometric axis. You can adjust the cursor orientation when you are working on the left,
top, or right plane of the drawing by using the F5 key or holding down the CTRL key and then
pressing the E key to cycle the cursor through different isometric planes (left, right, top). You
can change the vertical snap and grid spacing by entering values in the Snap Y spacing and
Grid Y spacing edit boxes. You will notice that the X spacing is not available for this option.

Polar Snap
You can use the polar snap with polar tracking. Here the cursor snaps to points at a specified
distance along the Polar alignment angles. You can select the PolarSnap radio button in the
Snap style & type area to set the snap grid to the polar mode. When you choose this option, the
normal snap options are not available. You can enter a desired distance in the Polar distance
edit box. If this value is zero, it assumes the same value as the Snap X spacing. The cursor snaps
along an imaginary path on the basis of Polar tracking angles, relative to the last point selected
or acquired. The angles can be set in the Polar Tracking tab of the Drafting Settings dialog box
(discussed later in the chapter).

Figure 4-36  Isometric snap gridFigure 4-35  Selecting Isometric
snap in Snap type & style area



4-30                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

For example, select the PolarSnap radio button, enter 0.5 in the Polar distance edit box, and
then choose the OK button. Select the POLAR button in the status bar for polar tracking.
Invoke the LINE command and select the starting point anywhere on the screen. Now move the
cursor; an imaginary path will be displayed at 0, 90, 180, and 270 angles (polar tracking) with
small cross marks displayed on this imaginary line at a distance of 0.5 (polar snap).

Note
The polar snap works along with polar and object tracking. Hence, it is used when the polar
tracking is on by selecting the Polar button on the status bar, or by selecting the Polar Tracking
On check box in the Polar Tracking tab of the Drafting Settings dialog box.

The snap type is also controlled by the SNAPTYPE system variable.

DRAWING STRAIGHT LINES USING THE ORTHO MODE
You can turn the Ortho mode on or off by choosing the ORTHO button in the status bar, or by
using the function key F8, or using the ORTHO command. The ORTHO mode allows you to
draw lines at right angles only. Whenever you use the pointing device to specify the next point,
the movement of the rubber-band line connected to the cursor is either horizontal (parallel to
the X axis) or vertical (parallel to the Y axis). To draw a line in the Ortho mode, specify the
starting point at the Specify first point prompt. To specify the second point, move the cursor
with the pointing device and specify a desired point. The line drawn will be either vertical or
horizontal, depending on the direction, in which you moved the cursor, see Figures 4-37 and
4-38.

Tip
You can use the status bar at the bottom of the graphics area to easily and conveniently toggle
between on or off for the different drafting functions like the Snap, Grid, and Ortho.

Figure 4-37  Drawing a horizontal line using the
Ortho mode

Figure 4-38  Drawing a vertical line using the
Ortho mode
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WORKING WITH OBJECT SNAPS

Object snaps are one of the most useful features of AutoCAD LT. They improve your performance
and the accuracy of your drawing and make drafting much simpler than it normally would be.
The term object snap refers to the cursor’s ability to snap exactly to a geometric point on an
object. The advantage of using object snaps is that you do not have to specify an exact point. For
example, to place a point at the midpoint of a line, you may not be able to specify the exact
point. Using the MIDpoint object snap, all you do is move the cursor somewhere on the object.
You will notice a marker (in the form of a geometric shape, a triangle for Midpoint) is automatically
displayed at the middle point (snap point). You can click to place a point at the position of the
marker. You also have a tooltip with the object snap marker. When you place the cursor on the
marker, a tooltip with the name of the object snap will be displayed. The object snaps recognize
only the objects that are visible on the screen, which include the objects on locked layers. The
objects on the layers that are turned off or frozen are not visible, and so they cannot be used for
object snaps. Object snaps can be invoked from the shortcut menu displayed when you press
and hold the SHIFT key down and right-click, see Figure 4-39, or from the Object Snap toolbar
shown in Figure 4-40.

You can invoke the shortcut menu to access the Object Snaps by holding down the SHIFT key on
the keyboard and then right-clicking in the drawing window. You can also invoke this shortcut
menu when you are inside any other sketching command. For example, invoke the CIRCLE
command and then right-click to invoke the shortcut menu. From the shortcut menu, choose
the Snap Overrides option to display the Object Snaps shortcut menu. The following are the
object snap modes in AutoCAD LT.

Toolbar: Object Snap

Figure 4-39  Selecting object snap
modes from the shortcut menu
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ENDpoint CENter       INSert From
MIDpoint QUAdrant       Node TRacking
INTersection TANgent       NEArest
APParent Intersection PERpendicular       NONe

AutoSnap
The AutoSnap feature controls the various characteristics for the object snap. As you move the
target box over the object, AutoCAD LT displays the geometric marker corresponding to the
shapes shown in the Object Snap tab of the Drafting Settings dialog box. You can change the
different AutoSnap settings such as attaching a target box to the cursor when you invoke any
object snap, or change the size and color of the marker. These settings can be changed from the
Options dialog box (Drafting tab). You can invoke the Options dialog box from the Tools menu
(Tools > Options), or from the shortcut menu when you right-click when no command is active,
or by entering OPTIONS at the Command prompt. You can also invoke it by selecting the
Options button in the Drafting Settings dialog box. When you choose the Drafting tab in the
Options dialog box, the AutoSnap options are displayed, see Figure 4-41.

You can select the Marker check box to toggle the display of the marker. You can use the Magnet
check box to toggle the magnet that snaps the crosshairs to the particular point of the object for
that object snap. You can use the Display AutoSnap tooltip and Display AutoSnap aperture
box check boxes to toggle the display of the tooltip and the aperture box. Selecting the Display
AutoSnap tooltip check box shows a flag that gives the name of the object snap that AutoCAD
LT has detected. You can change the size of the marker and the aperture box by moving the
AutoSnap Marker Size and Aperture Size slider bars, respectively. You can also change the
color of the markers through the AutoSnap marker color list box. The size of the aperture is
measured in pixels, short for picture elements. Picture elements are dots that make up the screen
picture. The aperture size can also be changed using the APERTURE command. In AutoCAD
LT, the default value for the aperture size is 10 pixels. The display of the marker and the tooltip
is controlled by the AUTOSNAP system variable. The following are the bit values for AUTOSNAP.

Figure 4-40  The Object Snap toolbar
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Bit Values Function
        0 Turns off the Marker, AutoSnap Tooltip, and Magnet
        1 Turns on the Marker
        2 Turns on the AutoSnapTooltip
        4 Turns on the Magnet

The basic functionality of Object Snap modes is discussed next.

Endpoint
The ENDpoint Object Snap mode snaps to the closest endpoint of a line or an arc. To
use this Object Snap mode, select the Endpoint button, and move the cursor (crosshairs)
anywhere close to the endpoint of the object. The marker will be displayed at the endpoint;

click to specify that point. AutoCAD LT will grab the endpoint of the object. If there are several
objects near the cursor crosshairs, AutoCAD LT will grab the endpoint of the object that is
closest to the crosshairs, or if the Magnet is on, you can move to grab the desired endpoint.
For Figure 4-42, invoke the LINE command from the Draw toolbar. The following is the prompt
sequence.

Specify first point: Select the Snap to Endpoint button from the Object Snap toolbar.
_endp of  Move the crosshair and select the arc.
Specify next point or [Undo]: Select the endpoint of the line.

Figure 4-41  The Drafting tab of the Options dialog box
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Midpoint
The MIDpoint Object Snap mode snaps to the midpoint of a line or an arc. To use this
Object Snap mode, select Midpoint osnap and select the object anywhere. AutoCAD LT
will grab the midpoint of the object. For Figure 4-43, invoke the LINE command from

the Draw toolbar. The following is the prompt sequence.

Specify first point: Select the starting point of the line.
Specify next point or [Undo]: Choose the Snap to Midpoint button from the Object Snap toolbar.
_mid of  Move the cursor and select the original line.

Nearest
The NEArest Object Snap mode
selects a point on an object (line, arc,
circle, or ellipse) that is visually closest

to the graphics cursor (crosshairs). To use this
mode, enter the command, and then choose
the Nearest object snap. Move the crosshairs
near the intended point on the object so as
to display the marker at the desired point and
then select the object. AutoCAD LT will grab
a point on the line where the marker was
displayed. For Figure 4-44, invoke the LINE
command from the Draw toolbar. The
following is the prompt sequence.

Specify first point: Choose the Snap to Nearest button from the Object Snap toolbar.
_nea to  Select a point near an existing object.
Specify next point or [Undo]: Select endpoint of the line.

Center
The CENter Object Snap mode allows you to snap to the center point of an ellipse,
circle, or arc. After selecting this option, you must point to the visible part of the

Figure 4-42 The ENDpoint Object Snap mode Figure 4-43  The MIDpoint Object Snap mode

Figure 4-44  The NEArest Object Snap mode
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circumference of a circle or arc. For Figure 4-45, invoke the LINE command from the Draw
toolbar. The following is the prompt sequence.

Specify first point: Choose the Snap to Center button from the Object Snap toolbar.
_cen of  Move the cursor and select the circle.
Specify next point or [Undo]: Select the endpoint of the line.

Tangent
The TANgent Object Snap allows you
to draw a tangent to or from an
existing ellipse, circle, or arc. To use

this object snap, place the cursor on the
circumference of the circle or arc to select it.
For Figure 4-46, invoke the LINE command
from the Draw toolbar. The following is the
prompt sequence:

Specify first point: Select the starting point
of the line.
Specify next point or [Undo]: Choose the
Snap to Tangent button from the Object
Snap toolbar.
_tan to  Move the cursor and select the circle.
Specify next point or [Undo]: Select the endpoint of the line (tangent of the circle).

Note
If the start point of a line is defined using the Tangent Object Snap, the tip shows Deferred
Tangent. However, if you end the line using this Object Snap, the tip shows Tangent.

Figure 4-47 shows the use of NEArest, ENDpoint, MIDpoint, and TANgent Object Snap
modes.

Figure 4-45  The CENter Object Snap mode

Figure 4-46  The TANgent Object Snap mode
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Figure 4-47  Using the NEArest, ENDpoint, MIDpoint, and
TANgent Object Snap modes

Figure 4-48  Location of the circle quadrants Figure 4-49  Quadrants in a rotated circle

Quadrant
The QUAdrant Object Snap mode is used when you need to snap to a quadrant point
of an ellipse, arc, or a circle. A circle has four quadrants, and each quadrant subtends an
angle of 90-degree. The quadrant points are located at 0-, 90-, 180-, and 270-degree

positions. If the circle is inserted as a block (see Chapter 14), that is rotated, the quadrant points
are also rotated by the same amount, see Figures 4-48 and 4-49.

To use this object snap, position the cursor on the circle or arc closest to the desired quadrant.
The prompt sequence for drawing a line from the third quadrant of a circle, as shown in Figure 4-50
is given next.

Specify first point: Choose the Snap to Quadrant button from the Object Snap toolbar.
_qua of Move the cursor close to the third quadrant of the circle and select it.
Specify next point or [Undo]: Select the endpoint of the line.
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Intersection
The INTersection Object Snap mode is used to snap to a point where two or more
lines, circles, ellipses, or arcs intersect. To use this object snap, move the cursor close to
the desired intersection so that the intersection is within the target box, and then specify

that point. For Figure 4-51, invoke the LINE command. The prompt sequence is given next.

Specify first point: Choose the Snap to Intersection button from the Object Snap toolbar.
_ int of  Position the cursor near the intersection and select it.
Specify next point or [Undo]: Select the endpoint of the line.

After selecting the Intersection Object Snap, if your cursor is close to an object and not close to
an actual intersection, the tooltip displays Extended Intersection. If you select this object now,
AutoCAD LT prompts and, for the selection of another object. If your cursor is close to another
object, AutoCAD LT marks the extended intersection point between these two objects. This
mode selects extended or visual intersections of lines, arcs, circles, or ellipses (Figure 4-52). The
extended intersections are the intersections that do not exist at present, but are imaginary and
formed if the line or arc is extended.

Figure 4-50  The QUAdrant Object Snap mode

Figure 4-52  Extended Intersection Object Snap
mode

Figure 4-51  The INTersection Object Snap mode
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Figure 4-53  Selecting the start point and then
the perpendicular snap

Figure 4-54  Selecting the perpendicular snap
first

Apparent Intersection
The APParent Intersection Object Snap mode selects projected or visual intersections
of two objects in 3D space. Sometimes, two objects appear to intersect one another in
the current view, but in 3D space the two objects do not actually intersect. The Apparent

Intersection snap mode selects such visual intersections. This mode works on wireframes in 3D
space (See Chapter 23 for wireframe models). If you try to use this object snap mode in 2D, it
works like an extended intersection.

Perpendicular
The PERpendicular Object Snap mode is used to draw a line perpendicular to or from
another line, or normal to or from an arc or circle, or to an ellipse. When you use this
mode and select an object, AutoCAD LT calculates the point on the selected object so

that the previously selected point is perpendicular to the line. The object can be selected by
positioning the cursor anywhere on the line. First invoke the LINE command; the prompt
sequence to draw a line perpendicular to a given line (Figure 4-53) is given next.

Specify first point: Select the starting point of the line.
Specify next point or [Undo]: Choose the Snap to Perpendicular button from the Object Snap
toolbar.
_per to   Select the line on which you want to draw perpendicular.

When you select the line first, the rubber-band feature of the line is disabled. The line will
appear only after the second point is selected. Invoke the LINE command. The prompt sequence
for drawing a line perpendicular from a given line (Figure 4-54) is given next.

Specify first point: Choose the Snap to Perpendicular button from the Object Snap toolbar.
_per to   Select the line on which you want to draw perpendicular.
Specify next point or [Undo]: Select the endpoint of the line.
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Figure 4-55 shows the use of the various object snap modes.

Draw the sketch shown in Figure 4-56. P1 and P2 are the center points of the top and bottom
arcs. The space between the dotted lines is 1 unit.

Node
You can use the NODe Object Snap to snap to a point object drawn using the
POINT command, or placed using the DIVIDE or MEASURE commands. In
Figure 4-57, three points have been drawn using the AutoCAD LT POINT command.

Figure 4-55  Using various object snap modes to locate points

Figure 4-56  Drawing for Exercise 3

Exercise 3 General
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Figure 4-57  Point objects Figure 4-58  Using the NODe object snap

Figure 4-59  The INSert Object Snap mode

You can snap to these points by using the NODe Snap mode. Invoke the LINE command and
the prompt sequence is as follows (Figure 4-58).

Specify first point: Choose the Snap to Node button from the Object Snap toolbar.
_nod of  Select point P1.
Specify next point or [Undo]: Choose the Snap to Node button from the Object Snap toolbar.
_nod of  Select point P2.
Specify next point or [Undo]: Choose the Snap to Node button from the Object Snap toolbar.
_nod of Select point P3.

Insert
The INSert Object Snap mode is used
to snap to the insertion point of a text,
shape, block, attribute, or attribute

definition. In Figure 4-59, the text
WELCOME is left-justified and the text
AutoCAD LT is center-justified. The point,
with respect to which the text is justified, is
the insertion point of that text string. If you
want to snap to these insertion points or the
insertion point of a block, you must use the
INSert Object Snap mode. Invoke the LINE
command and following is the prompt
sequence.

Specify first point: Choose the Snap to Insert button from the Object Snap toolbar.
_ins of   Select WELCOME text.
Specify next point or [Undo]: Choose the Snap to Insert button from the Object Snap toolbar.
_ins of   Select the block.
Specify next point or [Undo]: Choose the Snap to Insert button from the Object Snap toolbar.
_ins of   Select AutoCAD LT text.
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None
The NONe Object Snap mode turns off any running object snap (see the section
“Running Object Snap Mode” that follows) for one point only. The following example
illustrates the use of this Object Snap mode.

Invoke the Drafting Settings dialog box and select the Object Snap tab. Select the Midpoint
and Center check boxes. This sets the object snaps to Mid and Cen. Now, suppose you want to
draw a line whose starting point is a point closer to the endpoint of another line. After you
invoke the LINE command and move the cursor to the desired position on the previous line, it
automatically snaps to its midpoint. You can disable this using the NONe object snap by
choosing it from the Object Snap toolbar. You can select the desired point on the line. Once you
have selected a point, it continues the command with the specified object snaps.

From
The From Object Snap mode can be
used to locate a point relative to a
given point (Figure 4-60). For

example, to locate a point that is 2.5 units up
and 1.5 units right from the endpoint of a
given line, you can use the From object snap
as follows.

Command: LINE
Specify first point: Choose the Snap From
button from the Object Snap toolbar.
_from Base point: Choose the Snap to
Endpoint button from the Object Snap
toolbar.
_endp of Specify the endpoint of the given
line
<Offset>: @1.5,2.5

Note
The From Object Snap cannot be used as the running object snap.

Midpoint Between 2 Points
This Object Snap mode allows you to select the midpoint of an imaginary line drawn between
two selected points. Note that this Object Snap mode can only be invoked from the shortcut
menu. To understand the working of this Object Snap mode, refer to the sketch shown in
Figure 4-61.

In this sketch, there are two circles and you need to draw another circle with the center point at
the midpoint of an imaginary line drawn between the center points of the two existing circles.
The following is the prompt sequence.

Figure 4-60  Using the From Object Snap mode to
locate a point
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Command: CIRCLE �
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: Right-click and choose Snap
Overrides > Midpoint Between 2 Points from the shortcut menu.
_m2p First point of mid: Select the left circle.
Second point of mid: Select the right circle.
Specify radius of circle or [Diameter] <current>: Specify the radius of the new circle.

Tracking
The Tracking Object Snap Mode can be used to locate a point with respect to two
different points. When you select a point that is indicated by a plus sign, depending on
the direction in which you move the

cursor, an orthogonal imaginary line is
displayed either horizontally or vertically.
Then you can select another point to
display another orthogonal imaginary line in
the other direction. Notice that, now the first
imaginary line is not visible. The desired
point will be located where these two imaginary
lines intersect. You can use this option along
with the other Object Snap modes to locate a
point. For Figure 4-62, invoke the LINE
command from the Draw toolbar and then
use the temporary tracking as follows.

Specify first point: Choose the Tracking button from the Object Snap toolbar.
Next point  (Press ENTER to end tracking): Choose the Snap to Midpoint button from the
Object Snap toolbar.

Figure 4-61  Using the Midpoint Between 2 Points Object Snap
mode to locate a point

Figure 4-62  Using temporary tracking
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_mid of: Select the midpoint of the line and move the cursor horizontally toward the right.
Next point  (Press ENTER to end tracking): �
Specify next point or [Undo]: The tracking point is located, this tracking point is automatically
taken as the start point for the line. You can now specify the end point of the line.

Combining Object Snap Modes
You can also combine the snaps from the command line by separating the snap modes with a
comma. AutoCAD LT will search for the specified modes and grab the point on the object that
is closest to the point where the object is selected. The prompt sequence for using the Midpoint
and Endpoint object snaps is given next.

Command: LINE �
Specify first point: MID, END ��(MIDpoint or ENDpoint object snap.)
Select the object.

Note
In the discussions of object snaps, “line” generally includes xlines, rays, and polyline segments,
and “arc” generally includes polyarc segments.

Draw the sketch shown in Figure 4-63. The space between the dotted lines is 1 unit.

Exercise 4 General

Figure 4-63  Drawing for Exercise 4
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RUNNING OBJECT SNAP MODE

In the previous sections, you have learned to use the object snaps to snap to different
points of an object. One of the drawbacks of these object snaps is that you have to select
them every time you use them, even if it is the same snap mode. This can be solved by

using running object snaps. The Running Osnap can be invoked from the Object Snap tab of
the Drafting Settings dialog box (Figure 4-64). If you choose the Object Snap Settings button
from the toolbar, or enter OSNAP at the Command line, or choose Settings from the shortcut
menu displayed when you right-click on the OSNAP button in the status bar, the Object Snap
tab is displayed in the Drafting Settings dialog box. In this tab, you can set the running Object
snap modes by selecting the check boxes next to the snap modes. For example, to set Endpoint
as the running Object Snap mode, select the Endpoint check box and then the OK button in
the dialog box.

Once you set the running Object Snap mode, you are automatically in that mode and the marker
is displayed when you move the crosshairs over the snap points. If you had selected a combination
of modes, AutoCAD LT selects the mode that is closest to the screen crosshairs. For example,
you have selected the Endpoint, Midpoint, and Center check boxes in the dialog box. Now for
selection of a point when you move the cursor over a previously drawn line and whenever your
cursor is closer to the midpoint of the line, the marker is displayed there. You can also move the
cursor to the end of the line to invoke the Endpoint object snap. If you place the cursor over the
circumference of a previously drawn circle, the Center osnap is invoked. The running Object
Snap mode can be turned on or off, without losing the object snap settings, by choosing the
OSNAP button in the status bar. You can also accomplish this by pressing the function key F3 or
CTRL+F keys.

Note
When you use a temporary object snap and fail to specify a suitable point, AutoCAD LT issues an
Invalid point prompt and reissues the pending command’s prompt. However, with a running
Object Snap mode, if you fail to specify a suitable point, AutoCAD LT accepts the point specified
without snapping to an object.

The running osnap works only when it is turned on by using the Osnap button in the status bar.

Overriding the Running Snap
When you select the running object snaps, all other Object Snap modes are ignored unless you
select another Object Snap mode. Once you select a different osnap mode, the running OSNAP
mode is temporarily overruled. After the operation has been performed, the running OSNAP
mode goes into effect again. If you want to discontinue the current running Object Snap modes
totally, choose the Clear all button in the Drafting Settings dialog box. If you want to temporarily
disable the running object snap, choose the OSNAP button (off position) in the status bar.

Toolbar: Object Snap > Osnap Settings
Menu: Tools > Drafting Settings
Command: OSNAP
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If you override the running object snap modes for a point selection and no point is found to
satisfy the override Object Snap mode, AutoCAD LT displays a message to this effect. For
example, if you specify an override Object Snap mode of Center and no circle, ellipse, or arc is
found at that location, AutoCAD LT will display the message “No center found for specified
point. Point or option keyword required.”

Cycling through Snaps
AutoCAD LT displays the geometric marker
corresponding to the shapes shown in the
Object snap settings tab of the Drafting
Settings dialog box. You can use the TAB key
to cycle through the snaps. For example, if
you have a circle with an intersecting rectangle
as shown in Figure 4-65 and you want to snap
to one of the geometric points on the circle,
you can use the TAB key to cycle through
the geometric points. The geometric points
for a circle are the center point, quadrant
points, and the intersecting points with the
rectangle. To snap to one of these points, the

  Figure 4-64  The Drafting Settings dialog box (Object Snap tab)

Figure 4-65  Using the TAB key to cycle through
the snaps
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first thing you need to do is to set the running object snaps (center, quadrant, and
intersection object snaps) in the Drafting Settings dialog box. After entering a command, when
you drag the cursor over the objects, AutoSnap displays a marker and a SnapTip. You can cycle
through the snap points for an object by pressing the TAB key. For example, if you press the
TAB key while the aperture box is on the circle and the rectangle (near the lower left intersection
point), AutoSnap will display the intersection, center, and quadrant points one by one. When a
certain osnap is displayed, its pertaining object is highlighted by making it dashed. For example,
when the center or quadrant snaps are displayed the circle becomes dashed, and when the
intersection snap is displayed, both the circle and the rectangle become dashed. By selecting a
point, you can snap to one of these points.

Setting the Priority for Coordinate Entry
Sometimes you may want the keyboard entry to take precedence over the running Object Snap
modes. This is useful when you want to locate a point that is close to the running osnap. By
default, when you specify the coordinates (by using the keyboard) of a point located near a
running osnap, AutoCAD LT ignores the point and snaps to the running osnap. For example,
you select the Intersection object snap in the Object Snap tab of the Drafting Settings dialog
box. Now, if you enter the coordinates of the endpoint of a line very close to the intersection
point (Figure 4-66a), the line will snap to the intersection point and ignore the keyboard entry
point. You can set the priority between the keyboard entry and object snap through the User
Preferences tab of the Options dialog box (Figure 4-67). Select the Keyboard Entry radio
button and then choose OK. Now, if you enter the coordinates of the endpoint of a line very
close to the intersection point (Figure 4-66b), the starting point will snap to the coordinates
specified and the running osnap (intersection) is ignored. This setting is stored in the
OSNAPCORD the system variable and you can also set the priority through this variable. A
value 0 gives priority to running osnap, value 1 gives priority to the keyboard entry, and value 2
gives priority to the keyboard entry except scripts.

Tip
If you do not want the running osnap to take precedence over the keyboard entry, you can
simply disable the running osnap temporarily by selecting the OSNAP button on the status bar
to the off position. This lets you specify a point close to a running osnap. This way you do not
have to change the settings for coordinate entry in the Options dialog box.

Figure 4-66  Setting the coordinate entry priority
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USING POLAR TRACKING
Polar tracking is used to locate points on an angular alignment path. Polar tracking can be
selected by choosing the POLAR button on the status bar, by using the function key F10, or by
selecting the Polar Tracking On (F10) check box in the Polar Tracking tab of the Drafting
Settings dialog box (Figure 4-68). Polar Tracking constrains the movement of the cursor along a
path that is based on the polar angle settings. For example, if the Increment angle list box value
is set to 15-degree in the Polar Angle Settings area, the cursor will move along the alignment
paths that are multiples of 15-degree (0, 15, 30, 45, 60, and so on) and a tooltip will display a
distance and angle. Selecting the Additional angles check box and choosing the New button

Figure 4-67  The User Preferences tab of the Options dialog box

Figure 4-68  The Polar Tracking tab of the Drafting Settings dialog box
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allows you to add an additional angle value. The imaginary path will also be displayed at these
new angles, apart from the increments of the increment angle selected. For example, if the
increment angle is set at 15 and you add an additional angle of 22, the imaginary path will be
displayed at 0, 15, 22, 30, 45, and the increments of 15. Polar tracking is on only when the
Ortho mode is off.

In the Drafting Settings dialog box (Polar Tracking tab), you can set the polar tracking to
absolute or relative to the last segment. If you select the Absolute radio button, which is the
default, the base angle is taken from 0. If you select the Relative to last segment radio button,
the base angle for the increments is set to the last segment drawn.

Tracking Settings
You have different settings while working with
autotracking. These can be set in the Drafting tab of
the Options dialog box (Figure 4-69). If you choose
the Options button in the Polar Tracking tab of the
Drafting Settings dialog box, the Options dialog box
with the Drafting tab open is displayed. You can use
the Display polar tracking vector check box to toggle
the display of the angle alignment path for Polar
tracking. You can use the Display AutoTrack tooltip check box to toggle the display of tooltips
with the paths. You can also use the TRACKPATH system variable to set the path display
settings.

Tip
You need the Options dialog box quite frequently to change the different drafting settings.
When you choose the Options button from the Drafting Settings dialog box, it directly opens
the required tab. After making the changes in the dialog box, choose the OK button to get back
to the Drafting Settings dialog box. The Options button is available in all the three tabs of
the Drafting Settings dialog box.

FUNCTION AND CONTROL KEYS
You can also use the function and control keys to change the status of the coordinate display,
Snap, Ortho, Osnap, tablet, screen, isometric planes, running Object Snap, Grid, Polar, and
Object tracking. The following is a list of function and control keys.

F1 Help F7 Grid On/Off (CTRL+G)
F2 Graphics Screen/AutoCAD LT Text Window F8 Ortho On/Off (CTRL+L)
F3 Osnap On/Off (CTRL+F) F9 Snap On/Off (CTRL+B)
F4 Tablet mode On/Off (CTRL+T) F10 Polar tracking On/Off
F5 Isoplane top/right/left (CTRL+E) F11 Object Snap tracking
F6 Coordinate display On/Off (CTRL+D) F12 Dynamic Input On/Off

Figure 4-69  The AutoTrack Settings in
the Options dialog box (Drafting tab)
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Answer the following questions and then compare your answers to those given at the end of
this chapter.

1. The layers that are turned off are displayed on the screen but cannot be plotted. (T/F)

2. The drawing, in which you are working, should be in the named plot style mode (.stb) to
make the plot style available in the Layer Properties Manager dialog box. (T/F)

3. The grid pattern appears within the drawing limits, which helps to define the working area.
(T/F)

4. If the circle is inserted as a rotated block, the quadrant points are not rotated by the same
amount. (T/F)

5. You can also change the plot style mode from the command line by using the __________
system variable.

6. The __________ command enables you to set up an invisible grid that allows the cursor to
move in fixed increments from one snap point to another.

7. The __________ snap works along with polar and object tracking only.

8. The __________ Object Snap mode selects the projected or visual intersections of two
objects in 3D space.

9. The  __________ can be used to locate a point with respect to two different points.

10. You can set the priority between the keyboard entry and object snap through the __________
tab of the Options dialog box.

Answer the following questions.

1. You cannot enter different values for horizontal and vertical grid spacing. (T/F)

2 You can lock a layer, which will prevent the user from accidentally editing the objects in that
layer. (T/F)

3. When a layer is locked, you cannot use the objects in the locked layer for Osnaps. (T/F)

4. The thickness given to the objects in a layer, using the Lineweight option, is displayed on
the screen and is plotted. (T/F)

Self-Evaluation Test

Review Questions
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5. When you select more than one layer using the SHIFT key, which of the following options
is not displayed in the Layer shortcut menu in the Layer Properties Manager dialog box?

(a) New Layer (b) Select All
(c) Make Current (d) Clear All

6. Which of the following function keys acts as a toggle key for turning the grid on or off?

(a) F5 (b) F6
(c) F7 (d) F8

7. Which one of the following object snap modes turns off any running object snap for one
point only?

(a) NODe (b) NONe
(c) From (d) NEArest

8. Which one of the following object snaps cannot be used as running object snap?

(a) EXTension (b) PARallel
(c) From (d) NODe

9. Which of the following keys can used to cycle through the different running object snaps?

(a) ENTER (b) SHIFT
(c) CTRL (d) TAB

10. While working on a drawing, at any point in time you can save all the layers with their
present properties’ settings under one name and then restore it anytime later using the
__________ button in the Layer Properties Manager dialog box.

11. You can use the __________ window to locate the drawing data with the help of the search
tools and then use it in your drawing.

12. The grid pattern appears within the drawing __________, which helps to define the working
area.

13. The difference between the Off option and the Freeze option is that the frozen layers are
not __________ by the computer while regenerating the drawing.

14. The size of the aperture is measured in __________ , short for picture elements.

15. Using the Extension object snap, moving the cursor along the path displays a temporary
extension path and the tooltip displays __________  coordinates from the end of the line.
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Set up layers with the following linetypes and colors. Then make the drawing, as shown in
Figure 4-70. The distance between the dotted lines is 1.0 unit.

Layer name  Color  Linetype
   Object  Red Continuous
   Hidden  Yellow Hidden
   Center  Green Center

Set up layers, linetypes, and colors, as given in Exercise 5. Then make the drawing shown in
Figure 4-71. The distance between the dotted lines is 1.0 unit.

Figure 4-70  Drawing for Exercise 5

Exercises

Exercise 5 Mechanical

Exercise 6 Mechanical



4-52                                                                                              AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Exercise 7 Mechanical

Figure 4-72  Drawing for Exercise 7

Figure 4-71  Drawing for Exercise 6

Set up layers, linetypes, and colors and then make the drawing shown in Figure 4-72. The
distance between the dotted lines is 1.0 unit.
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Figure 4-74  Drawing for Problem Solving Exercise 1

Figure 4-73  Drawing for Exercise 8

Problem Solving Exercise 1 Mechanical

Set up layers, linetypes, and colors and then make the drawing shown in Figure 4-73. Use the
object snaps as indicated.

Draw the object shown in Figure 4-74. First draw the lines and then draw the arcs using appropriate
ARC command options.

Exercise 8 Mechanical
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Figure 4-75  Drawing for Problem Solving Exercise 2

Problem Solving Exercise 2 Mechanical

Draw the object shown in Figure 4-75. First draw the front view (bottom left) and then the side
and top views. Assume the missing dimensions.

Answers to Self-Evaluation Test
1 -  F, 2 -  T, 3 -  T, 4 -  F, 5- PSTYLEPOLICY, 6 -  SNAP, 7 - Polar , 8 - Apparent Intersection,
9 - Temporary Tracking, 10 - User Preferences


